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1
Introduction

The first chapter is a quick overview of Expert Stationery Shop.

Welcome to Expert Stationery Shop! 
This product was designed with the needs of the small office/home office in mind. We have included the tools
and features necessary to create your most common business communication designs: letterhead, envelopes,
business cards, fax covers, certificates, signs, advertisements, and unique company logos. To get you started,
we have included over 100 ready-made templates for a wide variety of occupations and businesses. Simply
choose a template, enter your personal information into the fields, and you are ready to print! If you are creative,
all templates can be modified in a limitless number of ways. We have also included 100 color clipart samples
from Imageline, Inc. and 30 True Type fonts to add to your designs.

We realize that a professional business image is essential to success. This is why we have worked closely with
some of the leading custom paper manufacturers and have built-in support for their most popular paper formats.
You can preview any item from a variety of letterhead papers, certificates, and colored papers, and more directly
on-screen to see what your designs will look like before you print. An easy ordering system makes it a snap to
contact the paper manufacturers, so you can place an order for any of the papers they offer.

We have included some of the most common layout features available in design programs such as selection,
alignment, draw order, grouping, and object manipulation tools to make your layouts easier to do. The WYSIWYG
interface is designed to show you on-screen what your layouts will look like exactly before you print them, so you
can spend more time creating your designs and less time proofing them.

This manual is designed to serve as a reference for all the features, tools, and projects of Stationery Shop. If you
have specific questions while you are working on the program, you can consult the on-line guide. Enjoy the pro-
gram!
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Stationery Shop Overview
The goal of the Stationery Shop program is to allow you to quickly and easily create and print the most common
business communication needs: letterhead, envelopes, business cards, fax covers, certificates, signs, advertise-
ments, and unique company logos.

Using the tools and features of Stationery Shop, you should be able to easily create these projects.You can use
any of the over 100 ready-made templates and modify them to your needs, or create your own from scratch. If you
choose, you can order sets of matching stationery paper from the paper manufacturers featured in the program to
coordinate your business image. The stationery projects included in Stationery Shop allow you to create matching
sets of letterhead, envelopes, business cards, and fax covers.

Note: Stationery Shop is not intended as a word processor, so you cannot type up your letters or import docu-
ments into your projects. However, it is very convenient and economical to create and print-out your stationery in
batches, then use them as you need them later. Stationery Shop is designed with this in mind, so we recommend
that you familiarize yourself with the operation of your printer’s manual feed and feeder bin paper orientation
before you attempt to print several items in a batch.
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Main Interface
Choose the Project Type from this screen.

Stationery Shop offers four Project Types:

1. Stationery - create a complete suite of popular stationery formats.
Letterhead 
Envelopes
Business Cards
Fax Covers

2. Certificate - create awards and certificates.
3. Ads/Signs - create advertisements, flyers, signs, or any other business communication.
4. Create-A-Logo - combine color clipart, fonts, and special text effects to create your own corporate image.You 

can save your logo and use it in other projects.
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Since these four different formats are usually used together, all of the ready-made templates in Stationery Shop
are "coordinated" that is, they share the same look, fonts, graphics, etc. Most of the custom papers supported by
the program include matching sets of letterhead, envelopes, and business cards.

STAT I O N A R Y PRO J E C T

When you select a Stationery Project, you can switch between the different formats by using the Navigator Bar.
Changing one layout, however, does not affect the others, so that you can have maximum flexibility in your
designs. Though each of the formats is independent, they are saved together into the same Project file.
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CE RT I F I C AT E PRO J E C T S

Stationery Shop lets you create certificates and awards for any occasion using the same tools and layout features
as in the Stationery Project.

The orientation of certificate projects is automatically set to landscape. There are a variety of handsome parch-
ment and colorful papers with which you can use to create almost any award.
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SI G N S A N D  A D S

The Signs and Ads project is the perfect place for creating free-form creations.

You can make flyers, advertisements, signs, notices, reminders, and almost any form of single-page communica-
tion you need in this project. All the tools and features of Stationery and Certificates are available in this mode.
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Layout Editor Screen
This is the Layout Editor screen, where you can create and edit your custom stationery designs.
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Common buttons for file operations, cut, copy, paste functions, and basic text alignment buttons are found on the
Top Toolbar. The Left Toolbar consists of special design controls such as Zoom, Align, and Insert objects. On the
right, the Clipart Toolbar has a special drag-and-drop interface to scroll through the available clipart images. The
Clipart Toolbar converts into the Paper Toolbar where you can scroll through and select from several custom paper
backgrounds. Use the Navigator Bar to switch between the different stationery project formats.
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2
Tutorial

This section briefly describes the process of creating a

sample stationery project.

Creating Sample Projects with Stationery Shop 

CR E AT I N G A  SA M P L E  STAT I O N E RY PRO J E C T

Within the Stationery Project, there are four popular stationery formats: letterhead, envelopes, business cards,
and fax covers.You can choose from one of the ready-made formats or you can create your own from scratch.

In this example, we will create stationery for a business. Let’s begin by using one of the sample templates
included in the program, changing the contents of a field, aligning some fields, and saving a logo to disk.
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1 Click on the Stationery Project button on the Interface screen.

When you first choose a Stationery Project, this dialog box appears. A list of previously saved Stationery projects
appears on the left. A preview of the currently highlighted project is displayed on the right.
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2 Click on the Create New Project button.

The first step in creating a new Stationery Project is to select a template and a background. The list on the left
display a hundred ready-made templates covering many professional occupations and styles. Stationery Shop
supports a variety of custom papers from leading paper manufacturers. Choose from any available paper shown
on the list by first selecting the manufacturer’s name and then the desired paper. A preview of your stationery and
paper selection is displayed in the Preview window.

3 Scroll down the Templates list and select the template named “Professional - Style 2”. A preview appears in the preview
window.

4 Select the Beaver Prints button and choose a paper style named Sonoma Blue.

5 Click on the Personalize Button.
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You can enter your own personal company information by clicking on the Personalize button. The information you
enter in these fields is applied to the template you have selected.You may leave fields blank. The fields you leave
blank are displayed on your layout with the field name in <brackets>.You can delete these fields if you do not want
them to appear.

6 Enter your personal information into the appropriate fields.

7 Click on OK.

Your stationery project will now be ready for editing in the Layout Editor screen.

You can now view the different stationery formats by using the Navigator Bar .
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8 Click on the Envelope button on the Navigator Bar.

9 Click on the Bus. Card button on the Navigator Bar.

10Click on the Fax button on the Navigator Bar.
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11Click on the Letterhead button on the Navigator Bar.

Each of the stationery projects shares the same "look" as the other, and each stationery project is initially dis-
played with a matching paper for its type, when available. If no matching envelope or business card paper is avail-
able, it is noted at the bottom of the screen.

Suppose you wish to change the phone number you entered in the Personal Information dialog box.

12Double-click on the Phone field. An edit box appears where you can make the desired changes. 

Next, let’s move the fields from the top center of the page over to the left so they are left aligned. First, let’s use
some visual aids to help us with the layout.

13From the View Menu, select Object Outlines. 

14From the View Menu, select Margins.

Now let’s select the objects we wish to re-position to the left side of the page.

15With the mouse, select all four objects that we want move. 

16Click on the Alignment button on the left toolbar.
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17Select the Left Align button.

All the objects are now aligned on their left edges.

18While the objects are still selected, move them over to the left side of the screen, then close the left margin.

As a last step, we want to make sure the text (as opposed to the object’s outline) is lined up on the left.

19Click on the Text Justify Left button on the top toolbar.

Note: this change only affects the current stationery format. Stationery Shop allows you to have independent lay-
outs in each of the formats.
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Assuming we like the way our logo works, we can save it as a logo so that we can use it again in other projects.

20Select the clipart object and the company name by holding down the shift key and clicking on each object.

21Click on the Selection button and select the Group button.

22From the Edit Menu, select Save As Logo. Call the file My Logo.lgo

We will insert this logo later into a different kind of project to illustrate the benefits of this feature.

Suppose we want to try out another background instead of the Sonoma Blue:
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23Click on the Paper Change button on the Clipart Bar.

A selection of papers appear on the Clipart Bar .

24Click on the desired selection on the Clipart Bar. The background now changes to the new selection.

A N OT E A B O U T B AC K G RO U N D S :

the backgrounds included in Stationery Shop are for visual purposes only and do not actually print out. The pro-
gram is designed to adjust the margins according to each paper design and to fit your template to the specific
paper you choose. There is a Paper Style named Printable Designs where you can select designs that will print
along with your layouts.

Now is a good time to save our work:

25Click on the Save button.

26Name the file "My First Stationery."

Our last step is to print out our letterhead. With Stationery Shop’s WYSIWYG interface, you can see a very good
representation of what your layout will look like when you print it. However, we have also included a Print Preview
screen where you can check your project one last time before you print. This is useful in special project types,
such as Business Cards where you don’t always see the full layout.

27Click on the Print Preview button to look your document over one last time before printing.

Note: if you are printing on custom paper, make sure you consult with your printer manual regarding manual feed-
ing and single-sheet printing. When you are ready, place the custom paper sheet in the feeder bin in the manner
indicated.

28When you are ready, click on the Print button.

At this point, we have printed out only the letterhead portion of the Stationery Project.You can repeat the steps
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above for each of the other types - business cards, envelopes, and fax covers, since they are essentially the
same.

CR E AT I N G A  SA M P L E  CE RT I F I C AT E PRO J E C T

Certificates are fun and inexpensive ways of rewarding employees or co-workers for good work. Stationery Shop
includes paper styles and fonts to let you create certificates for many different occasions.

In this example, we will create a Certificate of Achievement for an Employee, George Smith. Let’s begin by using a
ready-made template, adding George Smith’s name to it, and inserting the logo we saved in the stationery project
we created.

1 Select Certificate Project from the Interface screen.

2 Choose the Template named Achievement.
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3 Select Hudson River, then the paper style Parchment A104.

Let’s add a name to the award. We can do this by inserting a Text Object, changing its font, and entering the name
George Smith.

4 Click on the Insert Text button on the left toolbar.
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5 With the new text object selected, change the text’s font to Certificate by using the font control on the top toolbar.

6 Change the font size to 56 points by using the font size control on the top toolbar.

Now we are ready to enter George Smith’s name:

7 Double-click on the text.

8 Type George Smith in the edit box.

9 Press Return.
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You may have to fine-tune the position of the text so that it appears over the line.

For the last touch, lets add the logo we saved in the stationery project to our certificate.

10 Click on the Insert Logo button on the left toolbar.

11 Select the logo file My Logo.lgo

12 You can now position the logo where you want it to appear.

CR E AT I N G A  SA M P L E  S I G N/A DV E RT I S E M E N T PRO J E C T

All small businesses need to produce printed materials to advertise their products, notify customers of sales and
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designs to meet these needs.

In this example, we will create a For Sale ad for Stationery Shop Creations. We will use Shape Text and create a
colorful design complete with clipart and colored text.

1 From the Main Screen, select the Ads/Signs project button.

2 Click on the Create New Project button.

3 Select the Template called Create From Scratch.

stat_ch2.qxd  6/18/96 4:26 PM  Page 14



4 Choose No Paper Style.

We are ready to begin. Our first step is to create a colorful banner for our Software Sale. We will use Shape Text
for our sign.

5 Click on the Insert Shape Text.

6 Double-click on the Shape Text and enter Software Sale! Into the edit box.

7 Set the font to Billboard and the color to Blue.

Now that we have the font and color selected for our sign, we can add a drop-shadow to it and change its shape.
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8 With the Shape Text selected, click on the Text Effects button on the top toolbar.

9 Select the Shadow Tab.

10. Click on the Show Drop Shadow click box.
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Now let’s change the shape of the text by using the Shape Text options.

11. Click on the Headline tab.

12. Scroll down the listbox on the right and select the indicated shape.

13. Click on OK.

With our Shape Text ready, we can now add other elements to our layout. We can use the Clipart Bar to add a
graphic to enhance our sign. Note: Text Effects are only available in Windows™ 95 .

stat_ch2.qxd  6/18/96 4:29 PM  Page 17



14. From the Clipart Bar, scroll down until you see the star-burst shape shown below.

15. Drag the star-burst from the Clipart Bar and position it over the first letter S.

Notice that the Shape-Burst image appears on top of our text. To place it behind, we can use the Drawing Order
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15. Drag the star-burst from the Clipart Bar and position it over the first letter S.

Notice that the Shape-Burst image appears on top of our text. To place it behind, we can use the Drawing Order
button.

16. Click on the Draw Order button on the left toolbar.

17. Click on the Send to Back button.

The Star-Burst image now appears behind our text.
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We can continue to add text to our sign to complete our layout.

18. Add the following text to the design by using the Insert Text button on the left toolbar and change the font and color     
using the font controls on the top toolbar.

Let’s add some more clipart to make our layout more visually appealing.

stat_ch2.qxd  6/4/96 1:01 PM  Page 20



19. From the Clipart Bar, select the Diskette image and drag it onto the design.

The last step in completing our sign is to add your company logo, address, and any other information you want to
include in the design.You can import your own company logo if you have it in digital format, or you can create your
own using the Stationery Shop Create-A-Logo feature.
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CR E AT I N G A  SA M P L E  L O G O PRO J E C T

One of the more commonly used items as you create your stationery, ads, signs, or certificates is your company
logo. Stationery Shop lets you create logos from any combination of clipart, text, and special effects featured in the
program, and save them for use in all your projects, so you don’t have to re-do the artwork every time.

Using the Create-A-Logo project is essentially the same as the other projects with the exception that when you
save a design, Stationery Shop automatically groups the objects on the screen and saves them in the .lgo (logo)
file format.

For this example we will create a basic logo for Allen’s Photo Store and save it as an .lgo file.

1 Select the Create-A-Logo button from the Main Screen.

The layout editor appears. We are ready to begin composing our sample logo.

2 Scroll down the clipart bar, select the camera image, and drag it onto the workspace.

3 Scroll down the clipart bar and select the "shutter" symbol below.
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4 With the "shutter" symbol selected, click on the Draw Order button on the left toolbar and select Send to back.

5 Position the symbol behind the camera as shown.

Now that we have our basic graphic, let’s add the company name.

6 Click on the Insert Text button on the left toolbar.

7 Double-click on the text and type in Allen’s Photography in the edit box.

8 Place the text underneath the graphic and using the font size control, change the font size of the text to 40 points.

9 With the text highlighted, change the font to Astaire using the Font control on the top toolbar.
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Our basic logo for Allen’s Photography is now complete. Now all we have to do it save it as a logo file.

10. Click on the Save button on the toolbar.

11. Type in Allens.lgo as the name of the logo.

We’re done! We have now created and saved a logo which we can use in any Stationery Shop project.
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3
Tools/Toolbars

This Chapter discusses the toolbars found in the program
and how to use each tool.

Top Toolbar

FO R M AT T I N G TO O L S

When you are creating your own stationery, certificate, ads/signs, or logo projects, you want to lay out text and
clipart quickly and accurately. The following tools can help you:

New Project button - to create a new document.
Open Project button - to open a previously created document.
Save Current Project button - saves the current project.
Print button -launches the print screen.
Cut button - deletes selected text to be pasted somewhere else in the document.
Copy button - copies selected text into another section.
Paste button - pastes selected text to new place in the document.
Undo button - undoes the last executed command.

NEW PROJECT

OPEN PROJECT

SAVE CURRENT PROJECT PRINT

CUT COPY

UNDO

FONT FONT SIZE FONT COLOR

BOLD

ITALICS
UNDERLINE

TEXT EFFECTS

HELP

TEXT LEFT ALIGN

TEXT CENTER ALIGN

TEXT RIGHT ALIGN

12

PASTE
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Font button - to choose a font.
Font Size button - to change the font size.
Font Color button - sets the color of the selected text font.
Underline button - to underline selected text.
Bold button - to bold selected text.
Italics button - italicize selected text.
Text Left Align button - lines text to the left margin.
Text Center Align button - centers text.
Text Right Align button - aligns text to the right margin.
Text Effects button - calls up the Text Effects dialog box.
Help button - calls up the on-line help manual.
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Left Toolbar

The Left Toolbar contains special design controls, such as Zoom, Align, and Insert objects.

Zoom In button - magnifies the viewing area.
Zoom Out button - maximizes the viewing area.
Insert Text button - inserts a text object that can be edited.
Insert Shape Text button - inserts a text objects that can be shaped.
Insert Logo button - inserts a logo from the logo directory.
Layout Functions button - controls selection and alignment functions.
Personal Information button - brings up the Personal Information dialog box where data fields can be edited.

ZOOM OUT

ZOOM IN

INSERT TEXT

INSERT SHAPE TEXT

INSERT LOGO

LAYOUT FUNTIONS

PERSONAL INFORMATION

BUTTON
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SE L E C T  OB J E C T S B U T TO N

Select All Text button - use this button to select all text objects in your layout. This is useful when you want to
change the font properties for all of your text at one time.

Select All Objects button - use this button to select all objects - text, logos, and clipart.

Group button - when you have two or more objects selected, use this button to combine them into a single
"object."

Ungroup button - use this button to dismantle a grouped object into its separate components.

SELECT ALL TEXT OBJECTS

SELECT ALL OBJECTS

GROUP

UNGROUP

reveals following Select buttons:Select Objects button

Untitled  6/4/96 1:04 PM  Page 4



A L I G N  OB J E C T S B U T TO N S

Use the Align Objects buttons to line up objects.

Align Left button - when a single object is selected, it aligns it to the leftmost paper margin. When two or more
objects are selected, they are both aligned along their respective left margins.

Align Right button - aligns a single object to the right paper margin and aligns multiple objects along the right
margins.

Align Top button - aligns a single object to the top paper margin and aligns multiple objects along the top mar-
gins.

Align Bottom button - aligns a single object to the bottom paper margin and aligns multiple objects along the
bottom margins.

Center Vertically button - when a single object is selected, it is centered vertically on the page. When two or
more objects are selected, they are centered vertically in relation to each other.

Center Horizontally button - when a single object is selected, it is centered horizontally on the page. When two
or more objects are selected, they are centered horizontally in relation to each other.

Center on Page button - places single or multiple objects in the center of the current page.

Align Objects button reveals the following Align Buttons:

CENTER HORIZONTALLY

CENTER ON PAGE

CENTER VERTICALLY

ALIGN LEFT

ALIGN TOP ALIGN RIGHT

ALIGN BOTTOM
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DR A W OR D E R

calls up the draw order buttons

Bring Object To Front button - brings the selected object to the front.
Send Object To Back button - sends the selected object to the back.

Draw Order button
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File Menu

New Project - returns to the Main Screen where you can select a new project 
type.
Open Project - allows you to open a previously saved project file.

4
Stationery Shop Menus

This Chapter discusses the Menus in the program and how
to use each menu item.

stat_ch4.qxd  6/18/96 9:30 PM  Page 1



Save - saves the current project file.
Save As - saves the current project file under a different name.

Print - sends the current project to the printer
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Print Setup - allows you to change your printer settings.

Print Align - lets you fine-tune your printouts for accurate printing.
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Preferences - user preferences for Stationery Shop are changed here.

Personal Information - You can enter your own personal company information

Files - previously modified project files are displayed here.

Exit - quits Stationery Shop
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Edit Menu

Undo - cancels the last operation performed and restores the file to its previous state.

Cut - places the selected object in the program’s clipboard.
Copy - places a copy of the selected object in the program’s clipboard.
Delete - deletes the selected object.
Duplicate - makes a duplicate copy of the selected object.
Paste - puts an object stored in the clipboard on the document.

Select All Text - selects all text objects.
Select All Objects - selects all objects.

Group - combines all selected objects into one single object.
Ungroup - breaks up a grouped object into its component parts.
Save as Logo - saves a grouped object as a Logo object (.lgo) for later retrieval.
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View Menu

Rulers - turns the display of Rulers on/off.
Status Bar - turns the display of the Status Bar on/off.
Clipart Bar - turns the display of the Clipart Bar on/off.
Navigator Ba r - turns the display of the Navigator Bar on/off.

Guidelines - turns the display of Guidelines on/off.
Margins - turns the display of Paper Margins on/off.
Grids - turns the display of Snap to Grids on/off.
Object Outlines - turns the display of Object Outlines on/off.
Background - turns the display of the Background on/off.

Refresh Screen - re-draws the screen contents.
Zoom - changes the magnification of the screen.
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Insert Menu

Text - inserts a Text object into the project.
Shape Text - inserts a Shaped Text object into the project.
Clip-Art - inserts a Clipart object into the project.
Logo - inserts a Logo object into the project.
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Format Menu

Font - lets you set font attributes for the selected text.
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Text Effects - lets you set Headline text, drop-shadows, fills, and background color.
Note: Text Effects are only available in Windows™ 95 .

Center - controls for centering text horizontally or vertically on the page.
Align - controls object alignment - left, right, top, bottom, center.
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Draw Order - controls object layer position - bring to top, send to bottom.

Add Guidelines at Margins - automatically sets guidelines at the paper margins.
Remove All Guidelines - removes all guidelines.
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Stationery Type - select the stationery type you wish to view: letterhead, env., bus card, fax.
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Help

Index - brings up the Stationery Shop help file.
Using Help - brings up the Microsoft Help engine
About - information on Stationery Shop.
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Using Stationery Shop is a more in-depth explainaton of
the tools used in the program. 5

Using Stationery Shop

Basics

WYSIWYG IN T E R FA C E

Stationery Shop features a WYSIWYG interface (What You See Is What You Get). What you see on the screen
is an actual representation of your stationery as it will appear when you print it. Whenever you change margins,
rotate text, or add objects to your design, the printed output always reflects what you saw on the screen, with
the exception of the paper backgrounds which we have included only as a visual aide.

The editing and special tools included in Stationery Shop are designed to take advantage of this approach.
Consequently, most of the editing can be done directly on-screen. We recommend you spend some time study-
ing the interface, the buttons, and the ways of moving around in the program. If you need help on a button, tool
tips are available by resting the mouse cursor on the button before pressing it. If you need further help, an on-
line version of this guide is available.

ED I T I N G TE X T

To edit the contents of any text field, double-click on the desired text object.You can change the contents in the
edit control that appears. Press the Enter key when you are done editing.

A quick way of editing changes to text objects is to click on the Personal Information button.
Changes you make in the Personal Information screen are updated on your screen layout.
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SW I T C H I N G B E T W E E N STAT I O N E RY PRO J E C T TY P E S

When you first start a Stationery project, the letterhead format is displayed on the screen. To view any of the other
types, use the Navigator Bar. Click on the appropriate stationery format button to switch to that view.

Working with Project Files

STAT I O N E RY SH O P F I L E S

Each of the project types in Stationery Shop are saved as a unique project file format and file extension. Saved
stationery projects (.sta) are stored in a separate directory than Certificates (.cer), Signs/Ads (.sgn) , and Logos
(.lgo) . When you choose a project type from the Main Screen, you can load, work on, and save project files of that
particular type. Selecting New Project from the File menu or the toolbar opens the Main Screen where you can
choose a different project type.You can save your project files to any directory you wish, but it is easier to retrieve
your work if you save them to the appropriate directories.
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L OA D I N G  SAV E D PRO J E C T S

After you choose a project type from the Main Screen, a dialog box appears which lists all available files for that
project type. This list displays all of your previously saved files in the default directory.You can preview the contents
of each file by highlighting its name in the list box. If you saved your work to a different directory, you can use the
Browse button.

CR E AT I N G NE W PRO J E C T S

If you wish to create a new project file, click on the Create New Project button.
Creating a new Stationery, Certificate, or Signs/Ads project is a three step process. First, choose a template to
use. Next, select a paper type. The third step is to enter your Personal Information.

TEMPLATE SELECTION

WINDOW

PROJECT PREVIEW

WINDOW
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SE L E C T I N G A TE M P L A T E

Stationery Shop features 100 ready-made templates for stationery, 25 certificates, and 25 signs/ads from which
you can choose. The ready-made templates contain layouts, font selections, and logos that are pre-formatted and
ready to use. A default template is included that you can use if you prefer to make your own format and layouts
from scratch. When you choose a ready-made template, each of the accompanying types share the same "look."
For example, your letterhead has the same background, fonts, and basic layout as your envelopes, business
cards, and fax covers.

CH O O S I N G PA P E R

Stationery Shop supports custom paper designs from leading paper manufacturers, such as Beaver Prints,
Southworth, Peacetree, and Hudson River. By selecting the manufacturer, a list of their available styles appears.
Select from any of the papers listed to preview the paper style displayed in the Preview Window. Notice that each
paper design has unique margins. Stationery Shop adjusts the size of the selected template to match the working
margins of the paper you select.

TEMPLATES

PAPER COMPANY

PREVIEW
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PE R S O N A L I Z E

To personalize your stationery projects, click on the Personalize button. A dialog box appears where you can
enter information, such as your name, your company name, address, phone number, etc. This data is automatical-
ly entered into the fields on the template you have selected. If there are fields that don’t apply to your needs or you
don’t want to include them in your stationery, leave them blank. The program places the field name on the layout
with <brackets>.
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VI S UA L  A I D S A N D TO O L B A R S

Stationery Shop features visual aids to assist you in creating layout designs. These include rulers, paper margins,
guidelines, snap to grids, and visible object shapes. All of these items can be turned on or off through the View
menu on the top toolbar, or specific settings can be found for these in the Preferences option in the File menu.

The two rulers in Stationery Shop are divided into 1/16" tick-marks and cover the horizontal and vertical length of
the project page. When you move an object, Dimension Marks appear as gray blocks that indicate the width and
length of an object and its relative position on the page.You can use these marks as you re-size objects to a given
length or for accurate positioning.

RULERS

OBJECT DIMENSION

MARKS
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PA P E R  MA R G I N S

The margins for a selected paper are represented by red-dashed lines. The margins represent the working, print-
able area on the page, so items outside of these lines are either cut-off or they can’t print. Whenever you select a
custom paper or change the default paper, the current template with which you are working is re-sized to fit within
the new margin settings. The margins have been pre-set to accommodate the many custom paper designs avail-
able and to allow for a ½" margin at the bottom for Deskjet printers. If you wish to re-set these margins, use the
Margin Controls that appear on the toolbar. Note: most printers have a default print area ¼" on top, left, and right
margins so keep this in mind if you wish to set your margins beyond the default settings.

To Change Paper Margins on the Ruler , slide the Margin Control to its new position

MARGIN CONTROLS

PAPER MARGINS
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GU I D E L I N E S

You can activate Stationery Shop’s Guidelines by clicking on either of the rulers, holding down the left mouse but-
ton, and dragging the guideline.You can place guidelines anywhere on the page horizontally, as well as vertically.
Once the guideline is in place, you can move objects towards it. When the object is within several pixels, the
guideline becomes "sticky." In other words, it causes the object to attach itself to it. Guidelines are useful for align-
ing several objects along a specific position on a page.You can reposition a guideline by dragging it. To remove a
guideline, drag it back behind the rulers. An Add Guidelines at Margins function exists in the Format menu. It auto-
matically places guidelines exactly on the paper margins.

GUIDELINE
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SN A P TO GR I D

The Snap to Grid feature sets up a series of points at set intervals that are "sticky" in the same manner as guide-
lines.You can move objects and "snap" them to these points. This is useful when you want to layout several
objects at precise locations. The Snap to Grid option can be turned on/off through the Preferences option in the
File Menu. The intervals for the grid can be set in intervals of 1/16" and can also be set through the Preferences
option.

VI E W OB J E C T  OU T L I N E S

The View Object Outlines feature allows you to see a gray outline of all the objects on the page. This makes laying
out your page easier.You can turn on View Object Outlines from the View menu.

GRID POINTS

OBJECT OUTLINES
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STAT U S B A R

At the bottom of the Layout Editor screen is a status bar that provides you with information on your current project,
including the project type you are working on, the paper style you have selected, etc.

Inserting Objects into Your Layouts

IN S E RT TE X T

You can insert text into your layouts other than the default personal information fields.You can enter any informa-
tion into text objects by double clicking on it.

To enter a text object:

Click on the Insert Text button on the toolbar.
From the Insert menu, choose Text.

IN S E RT SH A P E TE X T

Shape Text is text that has been fitted into a selected shape or pattern.You can use this text for headlines, special
emphasis, or to create your own Logo look. Shape text can be given the same Text Effects as regular Text objects
including shadows, color fills, and backgrounds.

To insert Shape Text:

Click on the Shape Text button on the toolbar. To edit, double-click on it.
From the Insert menu, select Shape Text.
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IN S E RT L O G O

You can insert Logos you have created into any Stationery Shop project and make them part of your layout. This
feature is useful for quickly incorporating your company’s trademark into projects other than your stationery, such
as advertisements or certificates.

To insert a Logo:

Click on the Insert Logo button on the toolbar.
From the Insert menu, select the Logo 

IN S E RT CL I PA R T

Stationery Shop features a sampling of 100 color clipart images from ImagelineTM. This clipart is available from the
Clipart Toolbar on the right side of the screen. Up to six thumbnail previews are displayed at once. Use the scroll
controls to see all the available selections. Stationery Shop allows you to import files of type .bmp, .pcx, .tif, .wmf,
.mac, etc. Etc.

To Insert Clipart:

On the Clipart Bar, scroll through the thumbnail previews, and drag-and-drop your selection into the document.
From the Insert menu, select Clipart.

To Import other graphics files:

On the Clipart Bar, click on the Browse button. A dialog box appears where you can browse through your   
system for the file you wish to add.
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Text Effects
You can enhance the appearance of text objects by using Text Effects. These include Color Fills, Drop Shadows
and Background Color.

To add a Text Effect to a text object:

Highlight the desired text, then click on the Text Effects button. The Text Effects dialog box appears. Select the 
appropriate Effects Tab.
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CO L O R  F I L L S

There are four pre-set Color Fill functions. Choose the button for the desired effect.You must designate a Start
color and End color for these effects.

Solid Fill - colors the object the color of the Start color.
Gradient Fill - colors the object with a vertical transition of colors from the Start color to the End color.
Radial Fill - colors the object with a radial transition of colors from the Start color to the end color.
Conical Fill - colors the object with a sweeping transition of colors from the Start color to the end color.

PREVIEW
FIRST COLOR

SECOND COLOR
FILL PATTERNS

SOLID

GRADIENT

RADIAL

CONICAL
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DRO P SH A D O W

The Drop Shadow function creates a "shadow" effect behind the selected text. The color, position, and distance of
the shadow can be controlled.

To display a Drop Shadow:

Select the Shadow Tab in the Text Effects dialog box. Click on Display Shadow checkbox in the Settings frame 
to turn on the Drop Shadow.

Shadow Color: click on the Shadow color to change the color of the shadow. The default is light gray.

Position: choose the position of the shadow relative to the text from this control.

Spacing: set the spacing between your text and the shadow.

PREVIEW

SHADOW COLOR

POSITION OF SHADOW

DISTANCE OF SHADOW

SHOW SHADOW CHECKBOX
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B A C K G R O U N D CO L O R

Sets the background color of a text or clipart object.

To change the Background color of a text or clipart object:

Select the Background Tab in the Text Effects dialog box. Click on the Custom radio button and select the color
for the background.

PREVIEW

COLOR CONTROL

BACKGROUND COLOR
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SH A P E TE X T

Shape Text is a special kind of text which you can distort into a number of pre-set shapes. This text can be used to
give your layouts an artistic and creative look. Text Effect properties can be also applied to Shape Text . Shape text
can be very useful when creating your company logo, certificates, or signs and advertisements when you need a
unique and colorful look.

To use Shape Text in your layout:s:
Click on the Insert Shape Text button on the Toolbar. With the Shape Text selected, click on the Text Effects but-
ton. A new tab appears named Shape Text.

To change the shape of Shape Text:
Select the shape for the text from the Styles list box.

To edit the contents of Shape Text:
Double-clicking on it like a regular text object.

PREVIEW

SHOW OUTLINES ONLY

TEXT SHAPES SELECTION BOX
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CH A N G I N G  CU S TO M PA P E R S

Stationery Shop lets you change your custom paper selection at any time. This is a useful way of seeing how your
design will look with any of the many different custom papers available. The Clipart Bar doubles as a Paper Styles
bar where you can scroll through available papers from the featured manufacturers.

To change Custom Papers:

Click on the Paper Selection button on the Clipart Bar. The selections on the window become the paper styles
offered by the different manufacturers. To change a paper, simply click on the desired selection. The          
background of your layout, including its margins, changes automatically to reflect the new style.

The status bar displays the paper’s item # for ordering, as well as the manufacturer’s.

OR D E R I N G CU S TO M PA P E R S

If you like a particular paper style, you can place an order with the manufacturer directly. Click on the Order Paper
button on the Clipart Bar. Ordering information such as telephone numbers and how to order is available for each
manufacturer.You can get the part number for your paper from the status bar when you have selected the paper
you want.

PR I N T I N G

Once you have created a project in Stationery Shop, the final goal should be to print it onto good quality stationery
paper. The benefit of Stationery Shop’s WYSIWYG editing approach is that the layout you have created on the
screen looks like your final output, so there is no wasted time trying to get your project to look right.

There is a great number of different printers available, each which uses a unique set of driver software to make
printing work. While Windows has standardized the way printing is handled by application, not all printers offer the
same results. If you experience problems with the appearance of the output, it might be a simple matter of chang-
ing the printer settings, though this might not always be the case. Therefore, we strongly recommend that you con-
sult your printer manual and become familiar with its settings in order to get the best results from Stationery Shop.
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PR I N T I N G O N CU S TO M PA P E R

Before printing on custom paper (which is more expensive than regular paper) we recommend that you check the
paper feed operation of your printer.You may want to do a test print in order to determine exactly how to orient
your paper (face up or face down, top facing in or top facing out, etc.) in your paper feeder bin. This is also impor-
tant for printing envelopes, which often require a manual feed before each printing.

In cases where you are printing a large amount of items at one time (letterhead, for example), it might be easier to
load your printer’s paper bin with the custom paper in the correct orientation, then set the number of copies to
print. However, for most projects such as certificates, business cards, etc., we recommend that you print these out
one-by-one using your printer’s manual feed.
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PR I N T A L I G N M E N T

Since Stationery Shop requires precise alignment of your work on custom papers, we have included a feature that
allows you to make minute print alignment adjustments to your printout.

To Align Printing to your Particular Printer:

Choose the Print Align option from the File Menu. Click on the Test Print button.
Using the Nudge buttons, move the red area in the direction you wish. Each press of the button moves your 

layout 1/64th of an inch. To re-set, click on the Center button.
Click on the Test Print button until the design lines up on your paper. These settings are stored along with your
personal program preferences

ALIGNMENT GUIDE

NUDGE VALUES

NUDGE BUTTONS

TEST PRINT BUTTONS
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6
Frequently Asked Questions

Here is where you will find the most asked questions on
Expert Stationery Shop .

Stationery Shop FAQs

GE N E R A L

Can I print out the paper designs?

The paper designs are included to help you see what your stationery or paper will look like when printed. This
helps you choose from the many styles available. If you decide on a paper that you like, you can order it direct-
ly from the manufacturer by clicking on the Order Paper button on the clipart bar.

HOW D O I  O R D E R PA P E R ?

When you select a custom paper to display with your template, the manufacturer’s name and item number for
that paper appear on the status bar at the bottom of the screen. Click on the Order Paper button on the clipart
bar for information on the manufacturer’s phone number and how to place orders directly.

CA N  I  I M P O RT T E X T D O C U M E N T S I N TO STAT I O N E RY SH O P?

No. Stationery Shop was only designed to help you create and print basic layout designs for your stationery,
certificates, and signs, and print them out for later use. It is more practical and economical to print out your sta-
tionery first, then use your word processor later to print out more complex documents such as letters, etc.

stat_ch6.qxd  6/4/96 1:11 PM  Page 1



HOW D O I  I M P O RT M Y OW N P I C T U R E S?

You can import images in the most popular file formats (.bmp, .pcx, .tif, .gif, .jpg, etc.) into Stationery Shop. To load
your images, click on the Browser button located on the Clipart Bar, then look for the directory where your file is
stored.

Editing Projects

HOW D O I  K N O W H OW B I G A T E X T F I E L D I S?

You can display an object’s outline by selecting the View Object Outlines option in the View menu. This feature is
useful when you need to know the size of objects you are trying to position. The object’s outlines are for display
only and do not print out.

WH AT’ S T H E D I F F E R E N C E B E T W E E N A L I G N I N G T E X T A N D J U S T I F Y I N G T E X T?

Each text object, or field, has a bounding area. Within this area, text can be justified. That is, it can be positioned
next to the left, right, or it can be centered. Alignment refers to the position of the text object on the page or in rela-
tion to other objects.

HOW C A N  I  J U S T I F Y T E X T?

You can justify text left, right, or it can be centered by highlighting it, then clicking on one of the Justification but-
tons on the top toolbar.You can justify the text in a single field or for any number of selected fields.

HOW D O I  A L I G N T E X T?

Text fields can be aligned by clicking on the Alignment button on the Left Toolbar. There are seven alignment
options: top, bottom, right, left, center, horizontally, and vertically. If a single field or object is selected, it is aligned
to the margin, depending on which orientation was selected. If two or more objects are selected, then the object’s
edges are all aligned in the same orientation. For example, if you have three objects selected and you choose Left
Align, then all three objects are aligned along the left edges.
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WH AT A R E G U I D E L I N E S A N D H OW C A N  I  U S E T H E M?

Guidelines are temporary guides that you can place on your workspace. When you place an object near the
guideline, it becomes “sticky” and the object snaps to it. This is useful when you want to align several objects at a
common position on the page.You can place guidelines by clicking on the rulers area and dragging the guideline
to the desired position.

WH AT I S S N A P TO G R I D A N D H OW C A N  I  T U R N I T O N?

Snap to grid causes points at a specified interval on the page to become “sticky.” When you move objects around
the page, they stick to these snap-to-points. Since you can set the intervals for these points, such as at every ¼
inch, you can be sure that objects positioned on the same horizontal or vertical snap points are aligned.You can
turn on Snap-To-Grid through the Preferences menu in the File menu, and you can specify the interval for the
snap-to-points.

WH AT’ S T H E D I F F E R E N C E B E T W E E N  SH A P E TE X T A N D R E G U L A R T E X T?

Shape Text is different from regular text in that Shape Text objects can be twisted into different shapes.You can
choose the shapes for Shape Text by choosing them from the Text Effects dialog box. Shadows, Color Fills, and
Background Colors can also be applied to Shape Text.

HOW C A N  I  S E E T H E PA P E R M A R G I N S ?

You can view the paper margins by selecting the Margins option in the View menu. The paper margins indicate the
printable area of your design. Items placed outside this area are cut-off or they don’t print.

I ’ M I N  256-C O L O R M O D E A N D  I  I M P O RT A  256-C O L O R I M A G E A N D T H E

C O L O R S O F M Y B A C K G R O U N D G E T D I S TO RT E D. WH Y?

The paper backgrounds in Stationery Shop are displayed in 256 colors when you use Windows in 256-color mode.
Adding an image that has a different set of 256 colors causes a display conflict. The best thing to do is to turn off
the paper backgrounds by de-selecting the Background option in the View menu.
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Stationery Projects

HOW D O I  S E E T H E OT H E R S TAT I O N E RY T Y P E S?

Use the Navigator Bar to select the type of stationery you wish to see, or you can use Stationery Type option in
the Format menu.

I F  I  C H A N G E O N E D O E S I T A F F E C T T H E OT H E R O N E?

No. When you select a template, all the stationery types - letterhead, envelopes, business cards, and fax covers -
share the same “look.” They have the same fonts and basic layout. However, you are free to change any element
in any of the types without affecting the rest when you save the project.

WH E N I  L E A V E A F I E L D B L A N K I N T H E PE R S O N A L  IN F O R M AT I O N MA N A G E R,
T H E F I E L D N A M E S T I L L A P P E A R S I N B R A C K E T S .

Fields that you leave blank in the Personal Information Manager are displayed on screen so you can manually
remove them in a way that doesn’t upset the template’s layout. By leaving them on-screen marked in <brackets>,
you can see where a blank space appears once the field is removed and you can adjust the template accordingly.
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Certificate Projects

SO M E C E RT I F I C AT E PA P E R S H AV E W R I T I N G O N T H E M T H AT I S OV E R L A P P E D

B Y T H E T E M P L A T E T E X T. WH AT D O I  D O?

On certificates that have a heading such as “Certificate of Achievement,” you can simply delete the field on the
template that contains this text.

HOW C A N  I  G E T L I N E S O N M Y D E S I G N S?

There is a “line” image included in the clipart selection in the Clipart Bar.You can re-size this line to any length you
need.

Ads/Sign Projects

HOW D O I  C H A N G E T H E S I Z E O F SH A P E TE X T?

You can change the size of Shape Text by dragging its object handles and dragging it into its new size.

Logo Projects

DO I  N E E D TO M A N U A L L Y G RO U P O B J E C T S B E F O R E  I  S AV E T H E M A S A

L O G O O B J E C T ?

No, the program automatically groups all objects on the screen before saving them as a logo object.

WH AT S I Z E D O I  M A K E M Y L O G O ?

Generally, you should make your logo the exact size you want it to be in the designs. When you import it into
another project, the logo is the same size as how you saved it.
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CA N  I  E D I T A  L O G O O B J E C T , S U C H A S C H A N G I N G T H E T E X T?

Yes.You can ungroup a logo object into its component parts by highlighting it and selecting the ungroup com-
mand. Once the text part is separated, you can double-click on it like any text. If you want to save your changes,
re-group your objects and save them again as a logo.

Printing

HOW D O I  K N O W W H I C H WAY TO L O A D T H E C U S TO M PA P E R ?

Printers of different models from different manufacturers can vary widely. Most printers allow you to load several
pages in at one time and most should feature a way of manually loading single sheets. For best results, we recom-
mend you consult your particular printer’s User’s Guide for information on how paper should be loaded and do a
test printing first before using expensive custom paper.

HOW C A N  I  A D J U S T M Y P R I N T S E T T I N G S?

There are several things you can try if your printer is not printing within the print areas shown on-screen. The first
is to check how the paper is lined up when it is taken by the printer.You can adjust your paper tray or feeder guide
to insure that you are feeding the paper correctly. The second option is to use the Print Align Feature in the File
Menu
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7
Order Forms

All the information you need to order specialty papers.

Paper Ordering Information

Expert Stationery Shop supports fine quality custom papers from the leading paper manufacturers. You can
call the companies listed below directly for pricing and ordering information. You can obtain the item number
for the currently selected paper from the Status Bar at the bottom of the screen.

Expert Customers receive a 20% discount off of their first paper order. Please follow each company’s instruc-
tions on how to receive this discount.

Peacetree Environmentally Sound Paper &  Printing

Southworth Paper

Beaver Prints

Hudson River

Don’t forget to include Expert’s clip art images in your Stationery Shop image library. Click here more infor-
mation.
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Peacetree offers a wide selection of quality recycled papers and environmentally safer soy-based printing from
their Portland, Oregon offices. We are happy to answer questions regarding acidity, bleaching, post-consumer
content, etc. by calling us at (503) 233-5821 or by E-mail at ptree@teleport.com.

Call to order any of our papers at:

1-(800) 796-9469

or

E-mail: ptree@teleport.com

or

Website: http://www.teleport.com/~ptree

Expert Software customers receive a 20% discount off of their first order!  Please mention that you have pur-
chased Expert Stationery Shop to receive this discount. Have the paper item number ready when you call.
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SOUTHWORTH

When Southworth began crafting paper in 1839, the world was a much different place. Written communication tools consisted of little more than a sheet of paper
and a fine quill pen. The word “technology” was a generation away. It was a time when Southworth developed making paper  into an art form, and when its tradition
of hand crafted quality was established.

Through it all, Southworth papers have led the way, bringing the strength of its heritage and the backbone of over 150 years experience into the forefront of the busi-
ness world, while continuing to adhere to its reputation for making a premier line of quality cotton fibers.

Southworth products have been updated and new products created, yet the pride and craftsmanship behind every Southworth product remains as solid and depend-
able as the foundation on which the company was built.

Southworth Fine Paper Products are available from Staples®, Office Depot®, and other fine stationery retailers.
Please call or fax us at the number below for the store nearest you.

CUSTOMER SERVICE:
1-800-225-1839

Fax:
1-800-273-0538

P.O. Box 5006,150 Front Street, West Springield, MA 01090
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SO U T H WO RT H B U S I N E S S CA R D S

• Laser and Ink Jet compatible finish
• Microperforated for easy separation
• 38 lb. stock
• Software instructions and practice template included
• 250 cards per box

• Available in:

Gray Granite 25% Cotton Content BC914C
White Granite 25% Cotton Content BC924C
Ivory Granite 25% Cotton Content BC934C
Ivory Parchment Parchment Finish BC984C
Gold Edge * 25% Cotton Content BC#1

*Foil Stamped  to match the Gold Edge Letterhead

SO U T H WO RT H TR I -FO L D  B RO C H U R E S

• Laser and Ink Jet compatible finish
• 38 lb. Stock
• 25 per box
• Scored for ease of folding

• Available in:

Gray Granite 25% Cotton Content TF914C
White Granite 25% Cotton Content TF924C
Ivory Granite 25% Cotton Content TF934C
Ivory Parchment Parchment Finish TF984C
Gold Edge* 25% Cotton Content TF#1

*Foil Stamped/preprinted 2 sides to match the Gold Edge Letterhead
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SO U T H WO RT H PR E S E N TAT I O N FO L D E R S

• 2-Pocket Presentation Folders
• Both pockets cut to hold business cards
• Complements all Southworth papers
• 9 ½” x 12” - six to a pack

• Available in:

Gray Granite 25% Cotton Content PF#1
Ivory Granite 25% Cotton Content PF#3
Ivory Resume* 25% Cotton Content RF#3

8 ¾” x 11 ¼” and envelopes 9” x 12” - 5 each to a pack
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Main Street, Bellwood, PA 16617

Save up to 69% when you buy from us and not the other guys!

Prices start at only $0.17 per sheet in quantities of 100.

Only $16 for a huge Sample Pack and full line catalog.

To Place an Order, or for Pricing Information call:

814-742-6070 

Expert Software customers receive a 20% discount * off of their first order!  Please mention Exsoft to the sales
representative to receive this discount.

* Sorry, discount does not apply to samples.

The little guys from Main Street, Bellwood, PA (Population 1789) take on the big boys. Led by a guy named
Beave (Actually, entrepreneur of the Year in 1987 and featured in INC magazine) a small troupe of ad guys and
printers decided that you shouldn’t have to pay 30, 40, even 43 cents for a sheet of paper. We’re about to kick the
competition’s butts. Now! Out prices are down! Their prices are up! Wow!

Unlike our big corporate competitors, we don’t have millions of customers. So we can’t afford to lose a single one.
To assure legendary customer service, you’ll get your very own personal assistant to help you from start to finish.

We know it’s hard for you to select products without seeing them first hand. That’s why we have the BeaverPak -
the biggest sample of pre-printed laser papers in the world. That’s hundreds of sheets for just $16. It’s one sam-
ple of every paper in the BeaverPrints collection!  

Call now to order your BeaverPak - Item BPPAK1 Price $16 (retail value over $60).

•  Great paper prices
•  Imprinting for $0.02 per side
•  Complete Mail Shop too.
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Hudson River is pleased to offer paper styles from Paper Adventures. You won’t find these wonderful designs any-
where else. Each is an original Paper Adventures design created by one of their talented artists. Not only are the
paper styles beautiful, the paper is friendly to the environment. Wherever possible, recycled papers are used and
the designs are printed with 100% natural soy-based inks. And every product we sell is made with pride in the
United States.

Expert Software customers receive a 20% discount off of their first order!  Please mention that you have pur-
chased Expert Stationery Shop to receive this discount. Have the paper item number ready when you call.

To place an order, or for pricing information call:

1-800-272-7792

155 Katonah Ave, Katonah NY 10536

8 ½ x 11” Paper
Laser and ink jet 
compatible
28 lb. Stock
25 sheets per box
Printed with soy ink
(matching envelopes
included or sold separate-
ly)

Certificates
Laser and ink jet 
compatible
28 lb. Stock
25 sheets per box
Printed with soy ink
(9 x 12” envelopes avail-
able)

Business Cards
Laser and ink jet 
compatible
38 lb. Stock
25 sheets per box (10
cards per sheet)
Printed with soy ink
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A
About Stationery Shop
Add Guidelines at Margins
Align
Align Bottom Button
Align Left Button
Align Objects Button
Align Right Button
Align Top Button
B
Background
Background Color
Bold Button
Bring Object to Front Button
C
Center
Center Horizontally Button
Center on Page Button
Center Vertically Button
Certificate Projects
Changing Custom Papers
Choosing Paper
Clip-Art
Clipart Bar
Color Fills
Copy
Copy Button
Copyright and Trademark
Information
Create-A-Logo
Creating a Sample Certificate
Project
Creating a Sample Logo Project
Creating a Sample
Sign/Advertising Project
Creating a Sample Stationery
Project
Creating New Projects
Credits

Cut
Cut Button
D
Delete
Draw Order
Draw Order Button
Drop Shadow
Duplicate
E
Edit Menu
Editing Text
Exit
F
File Menu
Files
Font
Font Button
Font Color Button
Font Size Button
Format Menu
Formatting Tools
Frequently Asked Questions
G
Grids
Group
Group Button
Guidelines
Guidelines
H
Help Button
Help Index
Help Menu
I
Insert Clipart
Insert Logo
Insert Logo Button
Insert Menu
Insert Shape Text
Insert Shape Text Button

Insert Text
Insert Text Button
Inserting Objects Into Your
Layouts
Introduction
Italics Button
L
Layout Editor Screen
Layout Functions Button
Left Toolbar
Loading Saved Projects
Logo
M
Main Interface
Margins
N
Navigator Bar
New Button
New Project
O
Object Outlines
Open Project
Open Project Button
Ordering Custom Papers
P
Paper Margins
Paper Order Forms
Paste
Paste Button
Personal Information Button
Personalize
Preferences
Print
Print Align
Print Alignment
Print Button
Print Preview
Print Preview
Print Setup

Printing
Printing on Custom Paper
R
Refresh Screen
Remove All Guidelines
Rulers
S
Save
Save As
Save As Logo
Save Current Project Button
Select All Objects
Select All Objects Button
Select All Text
Select All Text Button
Select Objects Button
Selecting a Template
Send Object to Back Button
Shape Text
Signs and Ads
Snap To Grid
Stationery Projects
Stationery Shop Files
Stationery Shop Menus
Stationery Shop Overview
Stationery Type
Status Bar
Switching Between Stationary
Project Types
T
Test Print Button
Text
Text Effects
Text Effects Button
Text Left Align Button
Text Right Align Button
Tools/Toolbars
Top Toolbar
Tutorial
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U
Underline Button
Undo
Undo Button
Ungroup
Ungroup Button
Using Help
Using Stationery Shop
V
View Menu
View Object Outlines
Visual Aids and Toolbars
W
Working With Project Files
WYSIWYG Interface
Z
Zoom
Zoom In Button
Zoom Out Button
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Removing Win32S Under Windows 3.1
Warning: IF YOU REMOVE WIN32S v1.30,YOU WILL NO LONGER BE ABLE TO RUN 

APPLICATIONS THAT REQUIRE WIN32S.

If for some reason you like to remove the WIN32S v1.30 files from your system, do the following:

1. Remove the following line from the [386Enh] section in the SYSTEM.INI file:

device=<WINDOWS>\<SYSTEM>\win32s\w32s.386

where <WINDOWS> and <SYSTEM> are the lcoations of the Windows and System

directories, respectively.

2. Remove winmm16.dll from the following line in the [BOOT] section of the SYSTEM.INI file:

drivers=mmsystem.dll winmm16.dll

The line should look like this when you are done:

drivers=mmsystem.dll

3. Delete the following files from the <WINDOWS>\<SYSTEM> directory:

W32SYS.DLL

WIN32S16.DLL

WIN32S.INI

Winhlp32.cnt

Windows.hlp

Winhlp32.hlp

Winhlp32.exe
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4. Delete all of the files in the <WINDOWS>\<SYSTEM>\WIN32S directory,

then delete the subdirectory itself.

5. Restart Windows.
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